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 الملخص:

أصبحت التكنولوجيا تلعب دوراً حيوياً وعملياً مع  ادديعاد المكعاكخص صصوصعاً تلعت المتعلدعر بعلدارر المعوارد ال بيعيعر 

والاقتصعععادير والبنعععت التحتيعععر. لدعععد أالعععرت امبحعععاا العلميعععر نعععمك الن عععال الجفرا ععع  أك التكنولوجيعععا الجفرا يعععر 

ككلات وإدارر وتحليخ تلت الموارد. هذا يلدف إلت تحسيك والبرمجيات ذات الصلر تساهم بككخ كبير    حخ هذه الم

عمليات صن  الدرار والتعامعخ مع  معاعم التحعديات المتعلدعر بالتنميعرص اسعتفلاخ المعواردص إدارر البيتعر والمجتمع ص معك 

يعرص . ينعم ذلعت بنعاو قواععد بيانعات كعاملر ونمعاذ  علمآلع صلاخ اتصاذ قرارات أدل وأكثر إيجابير قاتمعر علعت معنل  

 بالإنا ر لإجراو دراسات ت بيدير واستصدام نماذ  ريانير وتحليلير.

( أهمير كبرى    مجالات أكاديمير عديدرص ولا سعيما  ع  المجعاخ AI   الآونر امصيررص اكتسب الذكاو الاص ناع  ) 

( إمكانعات Geo AI)يتعي  تكامعخ الجفرا يعا مع  العذكاو الاصع ناع   الجفرا يعر.الجفرا   وارتبا ه بنام المعلومعات 

جديدر ومتددمر لتوايف  رل حديثر    التعامخ م  مكعكلات متنوععر معك صعلاخ منلجيعر اسعتنادًا علعت نمذجعر راقيعر 

تمكك علماو الجفرا يا مك استصدام أدوات جديدر و عالر لفلعم وتحديعد الععالم معك اذ لرصد وتوق  التفيرات الجفرا يرص 

 حوللم. 

الإمكانات اللاتلر لاستصرا  معلومات أرنعير ذات مفعدى إلت تسلي  النوو علت ورقر ل   هذا السيالص تسعت هذه ا

العذكاو الاصع ناع   ع   مك صلاخ ت بيداتلبناو ابصمر كبديخ ومصدر موثول لبيانات  الفناتيرالجوير و صورالمك 

هنعا بكععكخ صععا  علععت  معع  التركيععد الجفرا يععر.المجعاخ الجفرا عع  وأحععدا التدنيعات المسععتصدمر  عع  ناععم المعلومعات 

 بكعكخ آلع  ودقيع  (Automated generation to extract building footprints) بصعمات المبعان  استصرا 

والبرنععام  مفتععوم المصععدر  QGISبرنععام   داصععخ بيتععر ناععم المعلومععات الجفرا يععر باسععتصدام الفنععاتير مععك صععور

Mapflow يدويا.م صرات  المبان     رس والتكاليف لتدليخ الوقت والجلود الم لوبر 

 .(الناصرير .Mapflow ,بصمر المبان QGIS,الجفرا يرص  المعلومات نام الاص ناع ص الذكاو): المفتاحية الكلمات
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Building footprint modeling An applied study of Al-Hatharat 
residential complex in Nasiriyah city using artificial intelligence 

within the environment of geographic information systems 
Assis Prof Hamid Alajrash 

Department of Geography- Faculty of Arts- Thi Qar University- Iraq 
Abstract: 

Technology has played a vital and practical role with the increase in problems, especially 

those related to the management of natural, economic and infrastructure resources. 

Scientific research within the geographic scope has shown that geographic technology 

and related software contribute significantly to solving these problems and managing and 

analysing those resources. This aims to improve decision-making processes and deal with 

most of the challenges related to development, exploitation of resources, management of 

the environment and society, through making more accurate and positive decisions based 

on an automated approach. This includes building comprehensive databases and scientific 

models, as well as conducting applied studies and using mathematical and analytical 

models. 

  Recently, Artificial Intelligence (AI) has gained great importance in many academic 

fields, particularly in the field of geography and its connection with GIS. The integration 

of geography with artificial intelligence (Geo AI) provides new and advanced capabilities 

to employ modern methods in dealing with various problems through a methodology 

based on sophisticated modelling to monitor and anticipate geographical changes, as 

geoscientists were able to use new and effective tools to understand and identify the 

world around them. 

In this context, this paper seeks to highlight the enormous potential of extracting 

meaningful ground information from high-resolution aerial and space images as an 

alternative and reliable source of building footprint data through the applications of 

artificial intelligence in the geographical field and the latest technologies used in 

geographic information systems. With a special focus here on automatic generation to 

extract building footprints automatically and accurately from satellite images within a 

geographic information systems environment using QGIS software and the open-source 

program Mapflow to reduce time, required efforts and costs in building mapping. 

Keywords: )artificial intelligence, geographic information systems, QGIS, building 

footprint, Mapflow. Nasiriyah(. 
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 :مقدمةال

لتديعيم معك أهعم المعلومعات امساسعير اللادمعر  بصعمر البنعاوعنصر أساس     المدك و المبان عد ت   

مثخ المساحر الإجمالير للمبنت ويو ر وصفاً أ نخ لصصاتصه المكانيعر مدارنعر بتمثيعخ ت والت  المبنت

مسععاحر امرو والعلاقععر بععيك المبععان  الند ععر مععك حيععا الموقعع  المكععان  والكععكخ والتوديعع  ونسععبر 

وعععدد  المبنععتصيمكععك إنععا ر معلومععات السععمات مثععخ نععو   ر بصععمر المبنععتص. بمجععرد تععو محي لععاو

 وغير ذلتص والاستصدامص ال واب ص

الصرات  مك  الحصوخ عليلاإما  ماصلمن در  ان هنات عدر  رل للحصوخ علت صرات  بصمر المب   

الرسعم علعت صعور  او الصرات صيدوم بلا مصتصوك بعلم   لمباكر التالمس  امرن  ا أو المساحيرص

بيانععات صععور امقمععار الصععناعير وأو إنكععاو مجموعععر بيانععات جديععدر باسععتصدام  امقمععار الصععناعير

 (Mharzi Alaoui, 2022) .مك صلاخ توايف الذكاو الصناع  عك بعدالاستكعار

قعد لا تكعوك هعذه  ذلعتصتو ر الصرات  المساحير مصدرًا جيدًا ورسمياً لبيانعات بصعمر المبنعت. ومع    

هعذه  صععوبر الوصعوخ العتو ع  بععو امحيعاك  التفصعيليرصالبيانات محدثعر وتفتدعر إلعت المعلومعات 

 يعر.العمليات المعددر الت  تن وي علت مصاوف أمنالروتيك و مك المؤسسات الرسمير بسبب البيانات

(Luo, 2017) يمكك أك تسعتفرل العمليعات اليدويعر لاسعتصرا  البيانعات معك مثعخ  ذلتصبالإنا ر إلت

 هذه الصرات  وقتاً  ويلاً وتت لب عملاً كثيفاً.

تتنمك  ريدر المس  امرنير  ريداً محددًا لإجراو العديعد معك عمليعات المسع  والديعاج لتسعجيخ    

يدعوم  اذ المبعان  بصعماتهعذه هع  ال ريدعر امكثعر دقعر لرسعم  إكالدوخ  يمككو البناو وامبعاد سمات

 ري  مك مصمم  الصرات  بديارر موق  ما  علياً ويدوموك برسم امبعاد والموق  الدقي  للمبنت علت 

 مثعخ هعذهبعععينلم الا اك نارًا مك  ري  رسم الصرات  يمكنعه التحدع  معك تص عي  المبنعت  .الصري ر

 .المسوحات امرنير تستفرل وقتاً  ويلاً للفاير وتستللت الكثير مك الموارد

 أصععب  صالمصععدر والمفتوحععرالبرمجيععات الحععرر ر الصععناع  مععك صععلاخ اقمععمبفنععخ تععو ر صععور ا

تحسّنت العملير الت    ص وبالتال (1111)الكبيس  و العجرشص  .سلولرالوصوخ إلت تلت الصور أكثر 

يتم بلا رسم بصمر البناو يدوياً علت تلت الصورص مما جعللا أكثر سلولر علت ام راد. وقد سم  هذا 

 رقمنعهالتددم بلنكاو صرات  للعديد مك المبان ص ممعا يععد تحسعيناً كبيعرًا. وعلعت العرغم معك ذلعتص  علك 

وتجُعرى ععادرً بكعكخ يعدوي ععك  ريع   بصمر المبان  مك الصور لا تداخ ملمر تت لب وقتاً  ويلاً 

امكثر  عالير للحصوخ علعت بصعمر المبعان  هع  اسعتصدام الصعور الجويعر  سلوبالا .رقمنر الميدات

والفناتير والاستكعار عك بعدص والاعتماد علت البيانات الت  يتم التدا لا بواس ر امقمار الصناعير 

تدنيععر الععذكاو الصععناع ص يمكععك تسععري  إنكععاو  أو ال ععاترات أو ال ععاترات بععدوك  يععار. وباسععتصدام

وأصععب  الآك مععك   ص(Ziming Li, 2021) أسععر منععلعات بصععمر البنععاو  عع  منععا   متعععددر بكععكخ 
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وتدليعخ الوقعت  صالبكعريرالممكك لصواردميات تحديد المبان  أك تدعوم بعذلت تلداتيعًا بدقعر مماثلعر للععيك 

 .بككخ كبيروالجلد الم لوب 

 مشكلة البحث 

تتمثخ مككلر البحا الت  تم تناوللا    هذه الدراسعر  ع  التحدع  معك  عاليعر وكفعاور اسعتصدام تدنيعات 

الورقعر تسعت  .لاستصرا  بصمر المبان  تلداتياً مك صور امقمار الصناعير (AI) الذكاو الاص ناع 

  :للإجابر علت امستلر التاليرالبحثير 

 الجفرا ير؟نام المعلومات  بيتر نمكباستصدام الذكاو الصناع  هخ يمكك تصميم صرات   .0

 المتاحعر  ع  هتعبدقالمبان   بصمرما هو أداو النل  الداتم علت الذكاو الاص ناع     تحديد  .1

QGIS  التدليدير؟مدارنر بالتدنيات 

ك  .2  QGIS إنعا    ع كيف يمكك دمع  الصواردميعر الداتمعر علعت العذكاو الاصع ناع  كمكعو ّ

 لتو ير واجلات سللر الاستصدام لاستصرا  البصمر؟

 اهداف البحث 

تحديعع  ت بيعع   عععاخ وسععري  و استككععاف اسععتصدام تدنيععات الععذكاو الاصعع ناع  الععت يلععدف البحععا

مك الصعور الفنعاتير باسعتصدام العذكاو  تلدات بككخ  )المنلعات المحي ر( لاستصرا  بصمر المبان 

 QGIS  بي  النموذ  الم ور باستصدام برنام بت ات نام المعلومات الجفرا يرعبر برمجي الصناع 

وذلت بلدف الحصوخ علت بيانعات  الفناتيرصلمفتوم المصدر لاستصرا  بصمر المبان  مك الصور ا

 لعانما وا  والتععرف علعت المبعان   المدروسعردقيدر وكاملر حوخ التودي  المكان  للمبان     المن در 

 . الصناعيرر اقمممك صور ارقمير صرات  لتصميم وصولا  المميدر    الصور الفناتير

 اهمية البحث 

بكعكخ الصعناعير مك صور امقمعار  المبان  تكمك أهمير هذا البحا    أتمتر عملير استصرا  بصمر

حيويعر لفلعم  روالعذي يعتبعر أداباستصدام الذكاو الصعناع   ع  بيتعر ناعم المعلومعات الجفرا يعر تلدات  

المبعان   ع  تحليعخ البنيعر العمرانيعر وتصعنيف  هعذا البحعاوتحليخ وإدارر المساحر العمرانير. يسعاهم 

 يتميععد بسععرعر المعالجععر وتحععديا مسععتمر للبيانععاتص ممععا يععو ر بيانععات دقيدععر وكععاملر حععوخ المبععان و

 اسعتصدام هعذه البيانعات  ع  يمكعكويعدويا  ر الوقت والجلد المبعذوخ  ع  تحليعخ الصعور الفنعاتير ويو

يمكعك أك تفيعد نتعات  هعذه  .وإدارر الكوارا البيتيرصوالمراقبر  الحنريصت بيدات عديدر    التص ي  

الدراسر الباحثيك والمص  يك الحنرييك وصنا  الدرار مك صلاخ تو ير أدار قوير و عالر لاستصرا  

 .بصمر البناو بدقر
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  فرضية البحث

 ص بالإنعا ر إلعت أدارQGIS تحليخ الجفرا   والتعلم الآل  المتعو رر  ع  برنعام أك استصدام تدنيات ال

MAPFLOW ص يمكعك أك يععؤدي إلععت تحسعيك عمليععر اسععتصرا  بصععمر المبعان  مععك الصععور الفنععاتير

تكوك قادرر علت التعرف علت البنت المعمارير المصتلفر بدقر مك الصور الفناتيرص وبالتال  ويمكك و

المعلومات لاستصرا  بصمر المبان  وتحديعد موقعلعا بكعكخ تلدعات  دوك الحاجعر لتعدصخ استصدام هذه 

ورسم صرات  معبرر عك  مما يحد  تكامخ البيانات    بيتر جفرا ير رقمير يسلخ التعامخ معلا يدوي

 .هذه البيتر.

 منهجية البحث 

تنوععرص بالإنعا ر إلعت يكعمخ جمع  البيانعات معك مصعادر مالعذي منل  استدرات  الالبحا علت  داعتم

 QGIS ت بيعع  المععنل  التدععان  الت بيدعع  والتكامععخ الرقمعع   عع  معالجععر البيانععات باسععتصدام برنععام 

 .تم استصدام هذه امدوات لإدارر البيانات وإعداد صري ر بصمر المبان  Mapflow وبرنام 

 أدوات البحث.

 QGIS 3.28 Firenze برنام   -0

 المصدر رمفتوح Mapflow.AI الادار -1

 Google Earth Proبرنام   -2

 Mappuzzleبرنام   -4

 

 حدود البحث 

قنععاو  الكععموف  عع وهععو جععدو مععك حعع  الحنععارات السععكن    مكانيععا بمجمععتتحععد من دععر الدراسععر 

ص ويد  جفرا يعا  ع  الجعدو (كرقا 5′14°46كمالا و 4′02°31) الناصرير عند تدا   داترر عرو

( ويكعععفخ مسعععاحر 0) رقعععارص الصري عععالناصعععرير مركعععد محا اعععر ذي الجنعععوب  معععك مركعععد قنعععاو 

 .( متر مرب 313,054)
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 من در الدراسر (0صري ر )

 

 QGIS 3.28 Firenzeالمصدر: الباحا بالاعتماد علت برنام  

 

 .(Artificial Intelligence)مفهوم الذكاء الصناعي : أولا 

الذكاو الصناع  هو مجعاخ معك مجعالات علعوم هندسعر الكمبيعوتر يلعدف إلعت ت عوير أنامعر وبعرام  

يتم تحدي   (1112)عرنوجص البكرير تمتلت الددرر علت تنفيذ ملام تت لب تفكيرًا ذكياً يكبه الددرات 

ذلت مك صلاخ استصدام تدنيات وأدوات مصتلفر تتي  للأنامر الحاسوبير التعلم مك البيانات والصبعرات 

يسعت الذكاو الصناع  إلت محاكار قدرات و السابدر واتصاذ الدرارات وتنفيذ الملام بككخ ذك  و عاخ

لاخص واتصعاذ الدعرارات. اذ يعتمعد العدخ البكري    مجالات مثخ التعلمص والتفكيرص والتحليخص والاسعتد

الذكاو الصناع  علت ت وير النماذ  والصواردميات الت  تمكك امنامر الحاسوبير معك  لعم وتفسعير 

 البياناتص واكتساب المعر رص والتعلم مك امص اوص وتحسيك امداو م  مرور الوقت.

مرص ونام التعرف علت الصوت تتنمك مجالات الت بي  الرتيسير للذكاو الصناع  الروبوتات المتدد

(ص General Intelligence(ص والععذكاو العععام )Big Dataوالصععوررص والتحليععخ للبيانععات النععصمر )

وت بيدععات الععذكاو الاصعع ناع   عع  ال ععب والتكععصي  الععذات ص ورسععم الصععرات  وتصععنيفلا والتجععارر 

ات الصعناعيرص وحمايعر السعكاك الإلكترونيرص والتحليخ المال ص وصناعر السياراتص والتحكم    العملي

   بدا  العالم والمساعدر علت إنداذ المديد مك امروام وتصفيعف المعانعار وذلعت ععك  ريع  تحسعيك 

 ,Smith) ال ععرل التعع  تتنبععع بحععدوا وتعديععد وسععاتخ للتعامععخ معع  الكععوارا قبععخ أو بعععد وقوعلععا .
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إلععت تفييععر جععذري  عع   ريدععر عمععخ المجتمعععات أدى الت ععور السععري   عع  هععذا المجععاخ هععذا (2018

 .(McCarthy, 2007) والاقتصاديات وحيار الناج علت ن ال واس .

ا   .اهمية استخراج بصمة المباني بشكل آلي من الصور الفضائية: ثانيا

 ,Huang)الإنساك وميدر جفرا ير    المنا   الحنرير الت  صنعلا كخ اليالأبرد مك المبان  ه  

IEEE Journal of Selected Topics in Applied Earth Observations and Remote)  .

الدععاموج الحععر": المن دععر الموجععودر  عع  موقعع  " (Building Footprint) المبععان  ربصععم تعُععرفو

عععادر مععا والتعع  يسععتصدملا هيكعخ المبنععت ويععتم تحديععدها معك صععلاخ محععي  مص ع  المبنععت والمكعرو  

والمنعاار ال بيعيعر والمرا ع  امصعرى ستبعد المرا   غير المبنير مثخ مواقف السيارات والكوار  ت

ويعععو ر تمثعععيلًا أ نعععخ  (.Building footprint, n.d) غيعععر المتعلدعععر بالبنعععاو  ععع  بصعععمر المبنعععت

لتعريعف امكثعر كعيوعًا العذي يسعتصدمه رسعامو الصعرات  واص    البيتر الجفرا ير المكانيرللصصات  

 عمليعر اسعتصرا  وتمثيعخ المبعان  واللياكعخ المصتلفعر علعت السع  هعو:  المبنعت بصعمرلوالمص  وك 

(Akhtar, 2020) ص وذلت باستصدام البيانات الجفرا ير والصور الجوير أو الصور الفناتير . 

تعد تكنولوجيا استصرا  بصمر المبان  بككخ آلع  معك الصعور الفنعاتير باسعتصدام العذكاو الصعناع  

مك الابتكارات اللامر    مجاخ تحليخ البيانات  MAPFLOWو QGISوبرام  مفتوحر المصدر مثخ 

ذه التدنير    تحويخ صور امقمار الصناعير والصور الجوير إلت معلومعات قيمعر الجفرا ير. تسلم ه

ومفصلر عك التودي  المكان  للمبان     المنا   المصتلفر. يتي  ذلعت للجلعات المعنيعر اسعتصدام هعذه 

البيانات    العديد مك الت بيدات العملير    مجالات مثخ رسم الصرات ص التص ي  العمرانع ص وإدارر 

  (Tanakorn Sritarapipat, 2017) لمواردص ورصد التفيرات البيتيرص وتحليخ المصا ر ال بيعيرا

ا   .اهمية استخراج بصمات المباني في رسم الخرائط: ثالثا

تعُتبععر بصععمر المبععان  مععك امدوات الجفرا يععر الحديثععر التعع  أثبتععت أهميتلععا البالفععر  عع  مجععاخ رسععم 

الصرات  وتحليخ البيانات الجفرا ير. تمثخ هذه العملير عملير استصرا  المبان  واللياكخ المصتلفر معك 

أهميعر كبيعرر  اللعو الصور الجوير أو الصور الفنعاتيرص وتحديعد مواقعلعا ومسعاحاتلا علعت الصري عر

 أهملا: ومك ساهم    عدر جوانبتو

يدععر ومفصععلر حععوخ الليكععخ والملامعع  دقععر المعلومععات: بصععمات المبععان  تععو ر معلومععات دق -0

الصاصر بالمبنت. هذا يسم  بلنكاو صرات  دقيدر وموثوقر تعكج الواق  بدقر عاليرص وبالتعال  

تحسيك الدقر    التص ي  والتحليخ واتصاذ الدرارات. كما يمكك أك تعو ر مجموععات بيانعات 

 منععا   الحنععريرالمبععان  المكععتدر مععك الصععور معلومععات قيمععر لرصععد المععدك ون اقععات ال

(Jochem, 2021)  ص لا سيما    امماكك الت  لا تحتوي علت صعرات  تص عي  تفصعيلير أو

 بيانات مساحير.



هـ4445-م  2023. لسنة الرابع /العددخامس المجلد ال / خامسةنة المجلة الدراسات المستدامة . الس  

 

0334 
 

تحليخ الكثا ر العمرانير: باستصدام بصمات المبان ص يمكك قياج كثا ر البناو    منا   معينر  -1

الفعل  للأرو. هذا يساعد    تحديد منا   الكثا عر وتحديد مدى تجم  المبان  والاستفلاخ 

 العالير والمنا   الدابلر للت وير وإدارر التوس  العمران .

الثلاثيععر امبعععاد: بصععمات المبععان  تمكععك مععك تحسععيك النمععاذ  تحسععيك تصععوير امرانعع  و -2

تصوير امران  وتعديد العناصعر البصعرير  ع  الصعرات ص مثعخ الانحعدارات والمنحعدرات 

كمععا يمكععك اسععتصدام بصععمات المبععان  لإنكععاو نمععاذ  ثلاثيععر  (1111)نسععورص لتنععاريج وا

ص ممعا يعو ر رؤيعر واقعيعر (Dostal & Korth, 2022)العمرانيعر امبعاد للمبعان  والمنعا   

 وتفصيلير للتناريج والبنير التحتير.

: بصمات المبان  يمكك استصداملا لرصعد التفييعرات الحنريررصد التفييرات والت ورات  -3

والت ععورات  عع  المععدك علععت مععر الععدمك. يمكععك تحععديا البيانععات وتحليععخ الععنم  الحنععري 

الحنعرير تحديع  الاسعتدامر  ورصد التوس  العمران  وتفير البنيعر التحتيعرص ممعا يسعاعد  ع 

(Ayala, Sesma, Aranda, & Galar, 2021). 

ا   .مراحل الستخراج التلقائي لبصمات المباني: رابعا

و يمعا  صتدنيعروص عوات مك ععدر مراحعخ  QGIS برنام     تكوك عملير استصرا  بصمات المبان  ت

 (:0الككخ ) المراحخهذه اهم يل  

 ( مراحخ الاستصرا  التلدات  لبصمات المبان 0الككخ )

 

 المصدر: مك عمخ الباحا     

  امولتالمرحلر 

يعُععدت تجليععد البيانععات الجفرا يععر المرحلععر امولععت وامكثععر أهميععر  عع   :البيانززات الجغرافيززة تجهيزز 

اسععتصرا  بصععمر المبععان . تتنععمك هععذه المرحلععر جمعع  المعلومععات المكانيععر والمكونععات الجفرا يععر 

للمن در المستلد ر. يتم جم  هذه البيانات مك مصادر مصتلفر مثخ الصرات  الرقمير والصعور الجويعر 

 الدراسععر من دععرذات دقععر عاليععر ل( IMAGE)  نععاتيروقععد تععم اصتيععار صععورر وامقمععار الصععناعير. 
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)مجمععع  دراسعععر اللمن دعععر  ZOOMوعمعععخ تكبيعععر مكعععان   Google Earth Proبواسععع ر برنعععام  

ت بيععع  كونعععه ينعععم اسعععتعمالات امرو الحنعععرير كحعععاخ المعععدك لنموذجعععا ل الحنعععارات السعععكن (

 .دقر الصورر الفناتير لتحسيك Mappuzzle  واستصدم برنام( 1الحنرير. كما    الككخ )

 لمن در الدراسر  ناتير( صورر 1الككخ )

 

 Mappuzzleوبرنام   Google Earth Proمك عمخ الباحا بالاعتماد علت برنام   المصدر:              

 الثانيرالمرحلر 

م ابدععر البيانععات و فنععاتير عع  هععذه المرحلععرص يععتم معالجععر الصععور ال :معالجززة الصززور وتحسززينها

 وتحسيك جودتلا وونوحلا (Georeferencing) إلت امرو الحديدير الفناتير الجفرا ير للصور

باسعتصدام  (Esri) Satelliteسعاج امصري عر والتعكد مك عملير الاسترجا  الجفرا   بالم ابدر مع  

تععم  بحيععاملععارر وكفععاور عمليععر  التعع  تت لععب QGISبرنععام  نععمك بيتععر  (MAP SWIPEامدار )

 (.2   الككخ ) . كماالدراسرتوايفلا بككخ يتناسب وهدف 
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( الم ابدر بيك الصورر الفناتير والصري ر امساج 2الككخ )

         
 QGIS 3.28 Firenzeالمصدر: مك عمخ الباحا بالاعتماد علت برنام  

 المرحلر الثالثر 

تحليخ جفرا   متددمر تعتمد علت التكنولوجيا الذكاو الاص ناع  ه  أدار  Mapflow :الأداةتثبيت 

تتمت  بمجموعر متنوعر مك المدايعا الديمعرص تكعمخ و لتسليخ وتحسيك عملير استصرا  بصمر المبان 

. QGIS (GeoAlert, 2021)دقر  اتدرص كفاور عاليرص قابلير للتوس ص أتمتر متددمرص وتكامخ مميد م  

أدار لا غنت عنلا وقيمعر جعدًا  ع  اسعتصرا  بصعمات المبعان ص وتسعلم  Mapflowتجعخ هذه المدايا 

هعذه  ك. تتنعمو عاليعر   تعديد الددرر علت رسم الصرات  وتنفيذ التحليخ الجفرا ع  المكعان  بكفعاور 

 تالندعععععععر علعععععععمعععععععك صعععععععلاخ  QGIS ععععععع   Mapflowتثبيعععععععت البرنعععععععام  المسعععععععاعد المرحلعععععععر 

(Plugins=>Manage and Install) كتعب يثم    مرب  البحعا  ومكMapflow البرنعام   وثبعت

وبعععد ذلععت التسععجيخ  عع  موقعع   روسععوف تالععر ايدونععر امدار علععت نا ععذر البرنععام  ولكنلععا غيععر مفعلعع

https://mapflow.ai                /   والحصوخ علت  (3الككخ ) مون    كما وص وات  ستمك صلاخAPI 

Token .الذي يصوخ المستصدم للدصوخ علت امدار واستصداملا 

 

 

 

 

https://mapflow.ai/
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 Mapflowمراحخ تثبيت امدار  (3الككخ )                        

 

 المصدر: مك عمخ الباحا

 المرحلر الرابعر 

يععتم تحميععخ البيانععات  QGISعلععت برنععام  وتفعليلععا بعععد تبيععت امدار  QGIS :تحميززل البيانززات فززي

للصعععورر الفنععاتير تمليعععدا  (shapefile)تحديعععد من دععر الدراسعععر وانكععاو عمليععر بللبعععدو الجفرا يععر 

 (.4الككخ ) .استصرا  بصمر المبان لا

 ر للصورر الفناتي (shapefileانكاو )( 4الككخ )

 

  QGIS 3.28 Firenzeعمخ الباحا بالاعتماد علت برنام   المصدر: مك      
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 المرحلر الصامسر 

:    هذه الص ورص يتم تحميخ وتدريب النماذ  الذكير بنعاوً للاستخراج النماذج الذكية وتطبيق تدريب

رر الصععوعلععت البيانععات الجفرا يععر التعع  تععم جمعلععا  عع  الص ععور امولععت. يععتم تععدريب النمععاذ  لتحليععخ 

 عع  اسععتصرا   Mapflowوهنععا يعععت  دور امدار  وتحديععد وتصععنيف المبععان  بكععكخ تلدععات  رالفنععاتي

. يمكعك إنكعاو (5كمعا  ع  الكعكخ ) من دعر الدراسعرمنعلعاً لتحديعد حعدود بععد اصتيعار بصمر المبعان  

 .Layer => Create Layer => New Shapefile Layer   مصصعععع  بالانتدععععاخ إلععععتالمنععععل  ال

ميعععدات مثعععخ الفابعععات والحدعععوخ لايمكعععك اصتيعععار مجموععععر متنوععععر معععك النمعععاذ  الآليعععر لاكتكعععاف 

هععو النمععوذ  الععذي ( المبععان بصععمر ككععف )يعععد  صلدراسععرا ههععذوالإنكععاوات وال ععرل والمبععان .  عع  

 (4كما    الككخ ) اصترناه

 تحديد حدود من در الدراسر( 5الككخ )

 

 QGIS 3.28 Firenzeعمخ الباحا بالاعتماد علت برنام   لمصدر: مكا 
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النموذ  الال  لاكتكاف بصمر المبان ( اصتيار 4الككخ )  

 

 QGIS 3.28 Firenzeعمخ الباحا بالاعتماد علت برنام   لمصدر: مكا

كما المعالجر  رتبدأ مرحل" start processingندر  ول الدر "وبال المعلماتصبمجرد تليتر جمي  و

و   الانترنت  وسرعر بناوً علت حجم المن در الذي تستفرقه الوقت تصتلف    د(ص وق2   الككخ )

             . % 21وتم تحديد بصمات للمبان  بدقر كبيره جدا تصخ الت  دقات صمسر هذه الدراسر استفرقت 

 انتلاو عملير المعالجرالنتات  بعد ( 2الككخ )

 

 QGIS 3.28 Firenzeعمخ الباحا بالاعتماد علت برنام   لمصدر: مكا
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 دسرالمرحلر السا

معك صعلاخ اسعتبعاد التحدع  بعد استصرا  بصعمر المبعان ص قعد تحتعا  النتعات  إلعت  :التحقق والتصحيح

والتصعحي  اليعدوي للتعكعد معك دقعر ( 1كما  ع  الكعكخ )دود من در الدراسر حبصمات المبان  صار  

 (.01)   الككخ  اكم الدراسرداصخ من در  للواق التصنيف وم ابدتلا البصمات و

                

 استبعاد بصمات المبان  صار  حدود من در الدراسر( 1ككخ )                 

 

 QGIS 3.28 Firenzeعمخ الباحا بالاعتماد علت برنام   لمصدر: مكا

 داصخ حدود من در الدراسر لبصمات المبان  التصحي  اليدوي( 01ككخ )
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 QGIS 3.28 Firenzeعمخ الباحا بالاعتماد علت برنام   لمصدر: مكا

 السابعرالمرحلر 

 ع  لمن دعر الدراسعر النتات  المستصرجر معك بصعمات المبعان   متستصد :المستخرجةالنتائج  ماستخدا

تونعع  الملامع  اللندسعير والجفرا يععر  بدقعرام عراف والدوايععا للمبعان  تحديعد تعم  يلععا رسعم صعرات  

هعذه  بككخ وان  ومنتام. امرن وتمثيخ التودي  والمكاك الجفرا   للمبان  علت الس    للمبان 

ترميععد  كععذلت تععمالفنععاتير البصععمات تمثععخ تمثععيلًا مجععردًا للمبععان  علععت الصععور الجويععر أو الصععور 

داصعخ المجمع .  رالعناصعر المصتلفعالصري ر النلاتير لمجم  الحنارات السكن  باستصدام أكواد تمثخ 

كمعا  غير السعكنير. والمنادخددر ال واب  المتعتم تصصي  أكواد للمبان  السكنير وأصرى للمبان  اذ 

 .تم تعييك ألواك مميدر لكخ  تر مك هذه العناصر لتمييدها بسلولر علت الصري ر

تمثخ هذه الترميدات اللونير البيانات المكانير ب ريدر بصرير وسللر الفلمص مما يمُكك المستصدميك 

مك تحديد و لم العناصر المصتلفر داصخ المجم  السكن  بسرعر. هذا يساعد    تحليخ البيانات 

هذه البيانات  تماستصدو وتصنيفاتلاواتصاذ الدرارات بناوً علت التودي  المكان  للعناصر المصتلفر 

يمكك تصنيف المبان   مك ناحير اصرى .(2والصري ر ) (1) ركما    الصري صرات  ال   إنكاو 

واالرت  باستصدام البصمات المستصرجرص مثخ التمييد بيك المبان  السكنير والتجارير والصناعير

مندخص مندخ بصمات من در الدراسرص اك هنات أربعر أصناف مك البصمات )مبنت سكن ص صري ر 

هذا  .(0الجدوخ )واعتمادا علت  (3غير سكن ص مبنت متعدد ال واب ( كما مون     الصري ر )

يمكك  ابحي معينركيفير استفلاخ امران  وتودي  المبان  علت مساحر  يفسرالتصنيف يمكك أك 

ك مك توجيه التص  ي  العمران  تحديد المنا   السكنير والتجارير والصناعير والصدميرص مما يمُكّ 
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ص مما (1111)الصا  ص  وتحديد أ نخ استصدامات للأران  وت وير المدك بككخ منام ومتوادك

 .يساهم    تحدي  التنمير المستدامر

 ( تمثيخ مبان  من در الدراسر علت الصور الفناتير1الصري ر )

 

 QGIS 3.28 Firenzeعمخ الباحا بالاعتماد علت برنام   لمصدر: مكا  

الملام  اللندسير للمبان  وتوديعلا الجفرا  ( 2الصري ر )

 

 QGIS 3.28 Firenzeعمخ الباحا بالاعتماد علت برنام   لمصدر: مكا      

 تصنيف المبان     من در الدراسر ( 2لصري ر )ا
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 QGIS 3.28 Firenzeعمخ الباحا بالاعتماد علت برنام   لمصدر: مكا

 Mapflowتصنيف ( تصنيف المبان  حسب 0جدوخ )                        

CLASS_ID CLASS NAME DESCRIPTION OSM refereral tag 

101 Apartment 

building 

Roof footprints of the 

multistorey apartment 

buildings 

building=yes 

building=residential 

building=appartments 

102 House Mostly private houses 

(usually represents a single 

household) 

building=house 

building=residential 

103 Industrial 

building 

Mostly industrial (Plants, 

large hangars, warehouses, 

etc.) 

building=industrial 

104 Commercial 

building 

Offices, retail, etc. building=commercial 

105 Other non-
residential 
buildings 

Garages, transformer 
boxes, small hangars, etc. 

 

 

 (.Mapflow, n.d) المصدر: 

ا   النتائج : خامسا

البحا الم روحر    هذه الدراسرص توصلت الدراسر إلت نتات  ذات أهميعر بعاردر  كلرمكستنادًا إلت ا

تسل ّ  النوو علت أهمير استصدام التدنيات الذكير    استصرا  بصمات المبان  وتحدي  تحسينات    

(. تبعيك النتعات  GISتصميم واستصدام صرات  بصمر المبان  نمك سيال نام المعلومات الجفرا ير )

أك استفادر مك تدنيات الذكاو الصناع  تمكك مك تصميم صرات  بصمر المبان  بدقر وكفاور متعددر. 
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هذا يكير إلت إمكانيعر تحسعيك عمليعات تصعميم الصعرات  وجمع  البيانعات المكانيعر باسعتصدام التدنيعات 

 الذكير.

الاصع ناع  يتفعول  ع  تحديعد بصعمر  علاور علت ذلعتص بينعت النتعات  أك العنل  المبنع  علعت العذكاو

المبان  بدقر أكبر مدارنر بالتدنيات التدليدير المعتمدر. هذا الاستنتا  يؤكد إمكانير تحسيك دقر و عاليعر 

 عملير تحديد بصمر المبان  باستصدام تدنيات الذكاو الصناع .

بي  عمل  كعناصر ت وب تم عرو أينًا نجام دم  الصواردميات المعتمدر علت الذكاو الاص ناع 

سععللر الاسععتصدام تسععلخ عمليععر اسععتصدام هععذه الصواردميععات  بواجلععاتو QGISإنععا ير  عع  برنععام  

بكفاور ويسُر. هذا التدديم يجعخ عملير اسعتصرا  بصعمر المبعان  أكثعر كفعاور معك حيعا تعو ير الوقعت 

 وسلولر التنفيذ.

الدراسعر أهميعر بعاردر لاسعتصدام التدنيعات باصتصارص أالرت النتات  الت  تعم التوصعخ إليلعا  ع  هعذه 

( الاسعتفادر GISالذكير    تصميم وتحليخ صرات  بصمر المبان . يمكك لعنام المعلومعات الجفرا يعر )

مك هذه التدنيات لتدعديم بيانعات مكانيعر دقيدعر و عالعرص ممعا يعدعم عمليعات التص عي  واتصعاذ الدعرارات 

 .المستنيرر    مجموعر متنوعر مك المجالات

 :بناوً علت نتات  هذه الدراسر وتحليللاص يمكك تدديم التوصيات التالير

ينُصعع  بتعديععد اسععتصدام التدنيعععات الذكيععرص مثععخ العععذكاو  :تع يزز  اسززتخدام التقنيززات الذكيزززة .0

الاص ناع ص    تصميم وتحليخ صرات  بصمر المبان . هذا سيساهم    تحسيك دقر و عالير 

 .و ير واجلات سللر الاستصدام للمستصدميكعمليات تحديد بصمر المبان  وت

ينُصعع  بتكامععخ التدنيععات الذكيععر معع  ناععم  :تكامززل التقنيززات مززع نظززم المعلومززات الجغرافيززة .1

بكععكخ أكبععر. ذلععت يسععاعد  عع  تحسععيك قععدرر الععنام علععت تععو ير  (GIS) المعلومععات الجفرا يععر

 .تبيانات مكانير دقيدر ومحدثر لدعم عمليات التص ي  واتصاذ الدرارا

يوُصت بتعديعد التعدريب والتوعيعر بعيك المصتصعيك والمسعتصدميك  :تع ي  التدريب والتوعية .2

حوخ اسعتصدام التدنيعات الذكيعر  ع  تصعميم وتحليعخ صعرات  بصعمر المبعان . ذلعت يسعاعد  ع  

 .الاستفادر الكاملر مك إمكانيات هذه التدنيات

يد معك الدراسعات الت بيديعر لتديعيم ينُص  بلجراو المد :إجراء الم يد من الدراسات التطبيقية .3

أداو التدنيات الذكير    مجاخ تصميم وتحليخ صرات  بصمر المبان     سياقات مصتلفر. ذلت 

 .سيساعد    توسي  الفلم حوخ مدى  عالير هذه التدنيات وتحديد مجالات التحسيك المحتملر
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والمؤسسات البحثير والد اعات يجب تعديد التعاوك بيك الجامعات  :تع ي  التعاون والبحث .4
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 .المبان  باستصدام التدنيات الذكير
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